
AVR PROG MKII

Instrukcja obsługi
rev. 3.0

Copyright © 2013 SIBIT www.sibit.pl AVR PROG MKII    1

http://www.sibit.pl/


Spis treści

1.Wprowadzenie...................................................................................................................................3

2. Opis...................................................................................................................................................4

            2.1 Diody LED.........................................................................................................................4

            2.2 Zworki................................................................................................................................5

            2.3 Złącze ISP...........................................................................................................................7

            2.4 Złącze TPI...........................................................................................................................8

            2.5 Złącze PDI..........................................................................................................................9

3. Instalacja sterowników do współpracy z AVR Studio, Atmel Studio, CodeVision .......................10

4. Instalacja sterowników do współpracy z BASCOM, AVRDUDE, ECLIPSE, ARDUINO ..........12

5. Podłączenie programatora do układu.............................................................................................20

            5.1 Podłączenie przez ISP......................................................................................................20

            5.2 Podłączenie przez PDI......................................................................................................21

            5.3 Podłączenie przez TPI......................................................................................................22

6. Konfiguracja...................................................................................................................................23

            6.1 AVR Studio.......................................................................................................................23

            6.2 Atmel Studio.....................................................................................................................26

            6.3 BASCOM-AVR................................................................................................................30

            6.4 AVRDUDE.......................................................................................................................32

7. Zmiana firmware ...........................................................................................................................33

            7.1 Instalacja programatora w trybie DFU.............................................................................33

            7.2 Obsługa programu Atmel FLIP........................................................................................37

8. Lista obsługiwanych układów........................................................................................................41

9. Nota prawna....................................................................................................................................42

10. Kontakt - wsparcie techniczne......................................................................................................43

Copyright © 2013 SIBIT www.sibit.pl AVR PROG MKII    2

http://www.sibit.pl/


1. Wprowadzenie

AVR PROG MKII to narzędzie do programowania wszystkich 8 bitowych 
mikrokontrolerów  AVR również z uwzględnieniem najnowszej rodziny ATXMEGA. 
Programator jest kompatybilny z AVRISP mkII.  Programator obsługuje magistrale 
ISP, PDI i TPI. 
W urządzeniu zastosowano buforowanie sygnałów we/wy co zwiększyło odporność
układu na zakłócenia oraz rozszerzyło zakres tolerowanych napięć zasilania 
programowanego układu. 
Komunikacja z komputerem odbywa się za pomocą złącza USB. Urządzenie może 
pracować w większości systemów operacyjnych (Windows XP, Windows VISTA, 
Windows 7, Windows 8).
AVR PROG MKII współpracuje z AVR Studio, CodeVisionAVR, Bascom AVR, AVR  
DUDE, ECLIPSE, ARDUINO.
Urządzenie bazuje na projekcie LUFA. Programator dostarczony jest z najnowszym
firmware LUFA który ma możliwość pracy w dwóch trybach – trybie zgodności z 
AVR Studio (obsługiwane programy – AVR Studio, Atmel Studio, CodeVision) i 
trybie zgodności z AVRDUDE (obsługiwane programy – AVRDUDE, BASCOM AVR,
ECLIPSE, ARDUINO). Przełączanie trybu następuje poprzez krótkotrwałe zwarcie 
jumpera MODE. 
Programator posiada bootloader przy pomocy którego można zmieniać firmware z 
poziomu komputera - nie jest potrzebne dodatkowe urządzenie. 
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2. Opis
2.1 Diody LED

POWER - dioda sygnalizująca zasilanie bufora wyjściowego
    programatora. Zasilanie bufora jest niezbędne do prawidłowej 

  pracy urządzenia. Bufor może być zasilony z USB (nałożona 
  zworka USB POWER w pozycji 3V3 lub 5V) lub z zewnątrz 
  (napięcie doprowadzone do pinu VCC programatora).

DATA - dioda sygnalizująca wymianę danych między komputerem a 
  programatorem. W pozycji spoczynkowej dioda powinna być 
  wygaszona a zapalać się tylko podczas transmisji USB 
  związanej z podłączeniem urządzenia, nawiązaniem 
  komunikacji z oprogramowaniem na komputerze lub 
  programowaniem mikrokontrolera. Przy pierwszym podłączeniu
  programatora dioda ta świeci się do czasu zakończenia 
  instalacji sterownika. 
  Ciągłe świecenie się diody może oznaczać błąd

    połączenia USB, nieprawidłową instalację sterownika 
    lub po prostu niezainstalowany programator.    

STATUS - świecenie się diody oznacza stan gotowości programatora. 
  Zgaszona dioda może oznaczać nieprawidłową inicjację      
  urządzenia, nieprawidłową instalację sterownika lub 
  niezainstalowanie programatora.

Diody  DATA  i  STATUS  informują  również  o  trybie  pracy  interfejsu.  
Dwa  jednoczesne  mignięcia  diody  zielonej  i  żółtej  po  podłączeniu
programatora  (lub  po  zmianie  trybu)  to  tryb  AVR  Studio  /  Atmel  Studio
natomiast  cztery  mignięcia  to  tryb  AVRDUDE  /  BASCOM.  W  trybie  DFU
(założona zworka BOOT, uruchomiony bootloader) diody DATA i STATUS są
wygaszone.
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2.2 Zworki

POWER - Zworka zdjęta – zasilanie programatora (bufora wyjściowego)  
   z programowanego układu.
  Zworka założona - pin VCC programatora jest pinem 

      wyjściowym z którego można zasilić układ programowany. 
  W  zależności od konfiguracji zworki napięcie na pinie VCC 
  może wynosić  3.3V lub ok. 5V. 

    

UWAGA ! JEŚLI PODŁĄCZONY UKŁAD  POSIADA WŁASNE ŹRÓDŁO 
ZASILANIA, ZWORKA POWER W PROGRAMATORZE POWINNA BYĆ ZDJĘTA A NAPIĘCIE

ZASILANIA PODŁĄCZONEGO MIKROPROCESORA 
DOPROWADZONE DO PINU VCC PROGRAMATORA *

*Zdejmując zworkę POWER odłączamy zasilanie USB od bufora wyjściowego 
programatora. Aby zasilić bufor należy doprowadzić napięcie z podłączonego 

mikrokontrolera do pinu VCC programatora.
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UWAGA ! Magistrala PDI w mikrokontrolerach XMEGA nie jest
przystosowana  do logiki 5V ! Podczas korzystania ze złącza PDI zworka POWER

powinna być w pozycji 3V3 lub powinna być całkowicie zdjęta - w takiej sytuacji
napięcie doprowadzone do pinu VCC nie powinno przekraczać 3,6 V.

Niezastosowanie się do zalecenia grozi uszkodzeniem programowanego
mikrokontrolera ATXMEGA. 

BOOT - Założona zworka w chwili podłączenia programatora do 
  komputera lub resetu programatora powoduje uaktywnienie 
  bootloadera (DFU). W trybie DFU diody DATA i STATUS 

    są wygaszone.  Podczas normalnej pracy zworka powinna być 
  zdjęta.

MODE - krótkotrwałe zwarcie pinów MODE powoduje przełączanie 
    pomiędzy trybami zgodności AVR STUDIO / AVR DUDE 

  (BASCOM). Zmiana trybu sygnalizowana jest jednoczesnym 
  mignięciem diody zielonej (DATA) i żółtej (STATUS). 

    Dwa jednoczesne „błyski” po zwarciu pinów MODE oznaczają  
  tryb AVR Studio / Atmel Studio natomiast cztery jednoczesne 
  mignięcia to tryb AVRDUDE / BASCOM.
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2.3 Złącze ISP

MOSI - linia wyjściowa. Dane nadawane w kierunku programator → 
  mikrokontroler.

VCC - w zależności od konfiguracji zworki POWER jest to wejście lub 
  wyjście. Jeśli zworka POWER jest zdjęta, do pinu VCC     

    niezbędne jest doprowadzenie napięcia zasilania z programowanego 
  mikrokontrolera. Napięcie to służy do zasilenia bufora wyjściowego 

            programatora i dla magistrali ISP powinno zawierać się w przedziale  
  od 1.8V do 5.5V.

  Przy założonej zworce POWER pin VCC jest pinem wyjściowym i 
      może służyć do zasilenia programowanego mikrokontrolera. 
    W  zależności od konfiguracji zworki napięcie na pinie VCC 

  może wynosić  3.3V lub ok. 5V.  Przy  tym należy pamiętać o   
  ograniczonej wydajności prądowej portu USB  (ok. 500mA), 

            bezpiecznie jest jednak nie przekraczać wartości  150mA.

GND - sygnał masy.

RST - reset.

SCK - sygnał zegarowy.

MISO - linia wejściowa. Dane odbierane przez programator.
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2.4 Złącze TPI

DATA - dwukierunkowa linia danych.

CLK - sygnał zegarowy.

RST - reset.

VCC - w zależności od konfiguracji zworki POWER jest to wejście lub 
  wyjście. Jeśli zworka POWER jest zdjęta, do pinu VCC     

    niezbędne jest doprowadzenie napięcia zasilania z programowanego 
  mikrokontrolera. Napięcie to służy do zasilenia bufora wyjściowego 

            programatora i powinno zawierać się w przedziale od 1,8V do 5,5V.

  Przy założonej zworce POWER pin VCC jest pinem wyjściowym i 
      może służyć do zasilenia programowanego mikrokontrolera. 
    W  zależności od konfiguracji zworki napięcie na pinie VCC 

  może wynosić  3.3V lub ok. 5V.  Przy  tym należy pamiętać o   
  ograniczonej wydajności prądowej portu USB  (ok. 500mA), 

            bezpiecznie jest jednak nie przekraczać wartości  200mA.

GND - sygnał masy.

Copyright © 2013 SIBIT www.sibit.pl AVR PROG MKII    8

http://www.sibit.pl/


2.5 Złącze PDI

DATA - dwukierunkowa linia danych.

CLK - sygnał zegarowy.

VCC - w zależności od konfiguracji zworki POWER jest to wejście lub 
  wyjście. Przy konfiguracji z zasilaniem zewnętrznym, doprowadzone  
  do pinu VCC napięcie powinno zawierać się  w granicach od 1,7V do 
  3,6V. 

UWAGA ! Magistrala PDI w mikrokontrolerach XMEGA nie jest
przystosowana  do logiki 5V ! Podczas korzystania ze złącza PDI zworka POWER
powinna być w pozycji 3.3V lub powinna być całkowicie zdjęta - w takiej sytuacji

napięcie doprowadzone do pinu VCC nie powinno przekraczać 3,6 V.
Niezastosowanie się do zalecenia grozi uszkodzeniem programowanego

mikrokontrolera ATXMEGA. 

GND - sygnał masy.
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3. Instalacja sterowników do współpracy z AVR Studio, Atmel 
Studio, CodeVision

Ten punkt instrukcji dotyczy instalacji sterowników przeznaczonych do współpracy z
oprogramowaniem AVR Studio, Atmel Studio oraz CodeVision. 
Instalacja sterowników przeznaczonych do pracy programatora AVR PROG MKII w 
środowisku BASCOM, AVRDUDE, ECLIPSE oraz ARDUINO znajduje się w 
kolejnym rozdziale instrukcji.
 
Uwaga ! Przed pierwszym podłączeniem programatora do komputera należy 
zainstalować środowisko AVR Studio lub Atmel Studio. W trakcie instalacji należy 
zaznaczyć opcję “Install/upgrade USB driver”. Jeśli nie była zaznaczona opcja 
instalacji sterowników proces należy powtórzyć lub zmodyfikować instalację 
bierzącą. Można to zrobić z poziomu panelu sterowania (w zależności od wersji 
systemu opcja – dodaj/usuń programy lub programy i funkcje). Po zainstalowaniu 
AVR Studio, programator należy podłączyć do komputera za pomocą kabla mini 
USB. Programator powinien być ustawiony w tryb AVR Studio (jest to ustawienie 
fabryczne). Tryb AVR Studio sygnalizowany jest dwukrotnym, jednoczesnym 
mignięciem diody zielonej i żółtej chwilę po podłączeniu programatora do 
komputera. Jeśli po podłączeniu programatora diody migną cztery razy, to 
koniecznie należy zmienić tryb pracy, jeszcze przed instalacją programatora. 
Przełączanie trybów odbywa się przez krótkotrwałe zwarcie pinów MODE.
Ustawienie trybu pracy jest zapamiętywane. Przy następnym podłączeniu 
urządzenie uruchamiane jest w ostatnio używanym trybie.
Po wykryciu nowego urządzenia system powinien zainstalować sterowniki 
automatycznie. Jeżeli pojawi się okno z wyborem trybu instalacji to należy wybrać 
instalację automatyczną lub wskazać lokalizację sterowników (dla systemu 32 bit - 
C:\Program Files\Atmel\Atmel USB\usb32 lub dla systemu 64 bit - C:\Program 
Files\Atmel\Atmel USB\usb64). Po poprawnej instalacji programatora, w oknie 
Menadżer urządzeń w gałęzi Jungo lub Atmel Devices powinno pojawić się 
urządzenie AVRISP mkII. Zielona dioda DATA powinna być wygaszona, natomiast 
świecić się powinna dioda żółta (STATUS) i ewentualnie czerwona dioda (POWER) 
jeżeli założona jest zworka POWER lub doprowadzone jest zewnętrzne napięcie do
pinu VCC.
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4. Instalacja sterowników do współpracy z BASCOM, 
AVRDUDE, ECLIPSE, ARDUINO

Ten punkt instrukcji dotyczy instalacji sterowników przeznaczonych do współpracy z
oprogramowaniem BASCOM-AVR, AVRDUDE, ECLIPSE oraz ARDUINO.
Instalację dla tego trybu można podzielić na dwa etapy – instalację sterownika 
AVRJungoUSB oraz instalację biblioteki LibUSB. Do prawidłowej pracy 
programatora AVR PROG MKII w tym trybie niezbędna jest instalacja zarówno 
sterownika (punkt 4.1)  jak i biblioteki (punkt 4.2)

4.1 Instalacja AVRJungoUSB

Sterowniki AVRJungoUSB należy zainstalować przed podłączeniem urządzenia do 
komputera. W tym celu należy uruchomić plik AVRJungoUSB.exe który znajduje się
na dołączonej do zestawu płycie (CD/ SOFTWARE/AVRJungoUSB.exe). Możliwe 
jest również ściągnięcie sterowników ze strony www.sibit.pl. 
UWAGA ! Programator powinien być przełączony w tryb AVRDUDE / BASCOM. 
Tryb ten sygnalizowany jest czterokrotnym, równoczesnym mignięciem diody 
zielonej i żółtej chwilę po podłączeniu programatora do komputera. Jeśli po 
podłączeniu programatora diody migną dwa razy, to koniecznie należy zmienić tryb 
pracy, jeszcze przed instalacją programatora. Przełączanie trybów odbywa się 
przez krótkotrwałe zwarcie pinów MODE. Ustawienie trybu pracy jest 
zapamiętywane. Przy następnym podłączeniu urządzenie uruchamiane jest w 
ostatnio używanym trybie.
Po wykryciu nowego urządzenia system powinien zainstalować sterowniki 
automatycznie. Po poprawnej instalacji programatora, w oknie Menadżer urządzeń 
w gałęzi Jungo lub Atmel Devices powinno pojawić się urządzenie AVRISP mkII. 
Zielona dioda DATA powinna być wygaszona, natomiast świecić się powinna dioda 
żółta (STATUS) i ewentualnie czerwona dioda (POWER) jeżeli założona jest 
zworka POWER lub doprowadzone jest zewnętrzne napięcie do pinu VCC.

W szczególnych przypadkach podczas instalacji sterowników AVRJungoUSB w 
systemach Windows 7 x64 oraz Windows 8 x64 system może automatycznie 
pobrać nieprawidłowy sterownik z Windows Update. Wówczas programator będzie 
widoczny w menadżerze urządzeń  jako LUFA  AVRISP MkII Clone z żółtym 
wykrzyknikiem. W takiej sytuacji sterownik programatora należy zainstalować 
ręcznie. W tym celu prawym klawiszem myszy wybieramy polecenie aktualizuj  
sterownik (aktualizuj oprogramowanie sterownika) , następnie wybieramy drugą 
opcję – Przeglądaj mój komputer w poszukiwaniu oprogramowania sterownika, 
wybieramy Atmel USB Devices,  wybieramy opcje z dysku i wskazujemy plik 
windrvr6 który znajduje się w lokalizacji C:\Program Files\Atmel\Atmel USB\usb64, 
klikamy dalej i instalujemy sterownik WinDriver.
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4.2 Instalacja LibUSB

Oprogramowanie LibUSB znajduje się na dołączonej do zestawu płycie (CD/ 
SOFTWARE/LibUsbDotNet_Setup.2.2.8.exe). Możliwe jest również ściągnięcie 
pliku ze strony www.sibit.pl. 
Po uruchomieniu aplikacji LibUsbDotNet_Setup.2.2.8.exe, klikamy “Next”

w następnym oknie akceptujemy licencję i również klikamy “Next” :

naciskamy “Next”
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instalujemy w standardowej lokalizacji, czyli dalej klikamy “Next”
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w następnym oknie zaznaczamy “Runtime Files” i standardowo klikamy "Next"

klikamy "Next" 
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W kolejnym oknie zaznaczamy pole "Install libusb-win32 with filter capabilities" 

i klikamy "Install"
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tutaj klikamy "Finish" z zaznaczoną opcją "Launch filter installer wizard"

Tak jak na poniższej ilustracji zaznaczamy pierwszą opcję - "Install a device filter" i 
przechodzimy dalej.
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W kolejnym oknie podświetlamy AVRISP mkII. Oczywiście programator musi być 
podłączony do komputera i ustawiony w trybie AVRDUDE / BASCOM. Jeżeli 
dotychczasową instalację LibUSB przeprowadzaliśmy bez programatora, 
urządzenie możemy podłączyć w tej chwili. 

Następnie klikamy "Install". Po poprawnie przeprowadzonym procesie instalacji 
powinno pojawić się poniższe okno:
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Pozostałe po instalacji okno można już zamknąć krzyżykiem w prawym górnym 
rogu ekranu.

Instalacja została ukończona.
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5. Podłączenie programatora do układu

5.1 Podłączenie przez ISP

Sygnały magistrali ISP z programatora należy połączyć z odpowiednimi liniami 
interfejsu ISP programowanego układu. Rozkład portów odpowiedzialnych  za 
programowanie w systemie (Serial Programming Pin Mapping) należy wcześniej 
sprawdzić w dokumentacji do posiadanego mikrokontrolera. W niektórych 
mikroprocesorach magistrala ISP pokrywa się ze sprzętową magistralą SPI (np. 
ATmega8), w innych magistrala do programowania ulokowana jest pod innymi 
portami (np. ATmega 128). Podłączając mikrokontroler do programatora należy 
więc zwrócić uwagę że nie zawsze ISP jest tożsame z SPI. 

Łączymy odpowiednio:
Złącze ISP programatora Magistrala ISP mikrokontrolera

MOSI MOSI

MISO MISO

SCK SCK

RST RESET

VCC* VCC

GND GND
* Linie VCC i GND powinny być połączone z VCC i GND programowanego 
mikrokontrolera. Wartość napięcia doprowadzonego do VCC powinna zawierać się 
w przedziale od 2V do 5,5V. Zworka POWER musi być zdjęta jeśli mikrokontroler 
zasilany jest ze swojego źródła. W przypadku zasilania programowanego układu z 
programatora, zworka ma być założona (w zależności od potrzeby w pozycji 3,3V 
lub 5V). 
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5.2 Podłączenie przez PDI

Sygnały magistrali PDI z programatora należy połączyć z odpowiednimi liniami 
interfejsu PDI programowanego układu. 

Łączymy odpowiednio:
Złącze PDI programatora Magistrala PDI mikrokontrolera

DATA DATA

CLK CLK

VCC* VCC

GND GND

* Linie VCC i GND powinny być połączone z VCC i GND programowanego 
mikrokontrolera. Przy konfiguracji z zasilaniem zewnętrznym wartość napięcia 
doprowadzonego do VCC powinna zawierać się w przedziale od 1,7V do 3,6V. 

UWAGA ! Magistrala PDI w mikrokontrolerach XMEGA nie jest
przystosowana  do logiki 5V ! Podczas korzystania ze złącza PDI zworka POWER
powinna być w pozycji 3.3V lub powinna być całkowicie zdjęta - w takiej sytuacji

napięcie doprowadzone do pinu VCC nie powinno przekraczać 3,6 V.
Niezastosowanie się do zalecenia grozi uszkodzeniem programowanego

mikrokontrolera ATXMEGA. 
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5.3 Podłączenie przez TPI

Sygnały magistrali TPI z programatora należy połączyć z odpowiednimi liniami 
interfejsu TPI programowanego układu. 

Łączymy odpowiednio:
Złącze TPI programatora Magistrala TPI mikrokontrolera

DATA DATA

CLK CLK

RST RST

VCC* VCC

GND GND

* Linie VCC i GND powinny być połączone z VCC i GND programowanego 
mikrokontrolera. Wartość napięcia doprowadzonego do VCC powinna zawierać się 
w przedziale od 1,7V do 5,5V. Zworka POWER musi być zdjęta jeśli mikrokontroler 
zasilany jest ze swojego źródła. W przypadku zasilania programowanego układu z 
programatora, zworka ma być założona (w zależności od potrzeby na pozycję 3,3V 
lub 5V).
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6. Konfiguracja

6.1 AVR Studio

Programator powinien być ustawiony w tryb AVR Studio. Tryb AVR Studio 
sygnalizowany jest dwukrotnym, jednoczesnym mignięciem diody zielonej i żółtej 
chwilę po podłączeniu programatora do komputera. Jeśli po podłączeniu 
programatora diody migną cztery razy, to należy zmienić tryb. Przełączanie trybów 
odbywa się przez krótkotrwałe zwarcie pinów MODE. Na komputerze powinny być 
zainstalowane sterowniki przeznaczone do pracy w tym trybie (rozdział 3. Instalacja 
sterowników do współpracy z AVR Studio, Atmel Studio, CodeVision).

Konfigurację programatora w AVR Studio prześledzimy na podstawie wersji 4.19 
środowiska.
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W celu połączenia z programatorem wybieramy AVR Studio -> Tools -> Program 
AVR -> Connect.

W oknie Select AVR Programmer jako Platform wybieramy AVRISP mkII ,port USB i
naciskamy Connect
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Po kliknięciu Connect powinno pojawić się okno obsługi programatora.

Uwaga ! AVR Studio nie posiada automatycznego wykrywania typu podłączonego  
do programatora mikrokontrolera, dlatego bardzo ważne jest, żeby przed 
przystąpieniem do jakichkolwiek operacji związanych z programowaniem, w polu 
Device and Signature Bytes zakładki Main ręcznie wybrać z rozwijanej listy typ 
docelowego mikroprocesora. 
Wciskając przycisk Read Signature należy sprawdzić czy prawidłowo jest 
rozpoznawana sygnatura (Signature matches selected device). Jeśli odczytana 
sygnatura nie pasuje do typu wybranego mikrokontrolera (WARNING:Signature 
does not match selected device!), należy zweryfikować poprawność połączeń 
między programatorem a mikrokontrolerem, zwrócić uwagę na właściwe zasilanie 
układu, upewnić się czy w polu Device and Signature Bytes prawidłowo został 
wybrany typ mikrokontrolera.
Warto również ustawić optymalną prędkość programowania (zakładka Main, 
przycisk Settings) pamiętając przy tym o zależności iż częstotliwość magistrali 
programatora powinna być równa lub mniejsza od ¼ częstotliwości taktowania 
programowanego mikrokontrolera. 
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6.2 Atmel Studio

Programator powinien być ustawiony w tryb  AVR Studio. Tryb AVR Studio 
sygnalizowany jest dwukrotnym, jednoczesnym mignięciem diody zielonej i żółtej 
chwilę po podłączeniu programatora do komputera. Jeśli po podłączeniu 
programatora diody migną cztery razy, to należy zmienić tryb. Przełączanie trybów 
odbywa się przez krótkotrwałe zwarcie pinów MODE. Na komputerze powinny być 
zainstalowane sterowniki przeznaczone do pracy w tym trybie (rozdział 3. Instalacja 
sterowników do współpracy z AVR Studio, Atmel Studio, CodeVision).

Konfigurację programatora w Atmel Studio prześledzimy na podstawie wersji 6.1 
(SP2) środowiska.
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W celu połączenia z programatorem wybieramy AtmelStudio -> Tools -> Device 
Programming  

następnie Tool → AVRISP mkII, w polu Device wybieramy typ podłączonego 
mikrokontrolera i wciskamy Apply
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Po naciśnięciu Apply programator powinien zostać rozpoznany i wyświetlona 
zostanie pierwsza zakładka – Interface settings z odczytaną prędkością zegara ISP.

W polu Device signature należy wcisnąć Read w celu weryfikacji sygnatury 
podłączonego procesora. Jeśli odczytana sygnatura odpowiada nazwie 
mikrokontrolera który wybraliśmy z listy Device, w dolnej części okna pojawi się 
komunikat o treści Reading device ID...OK. Odczyt wartości w polu Target Voltage 
jest symulowany więc bez względu na rzeczywistą wielkość cały czas będzie 
zwracana wartość 3,3V. 
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Jeśli odczytana sygnatura nie pasuje do typu wybranego mikrokontrolera, wartość 
sygnatury zostanie podświetlona na czerwono i zostanie wyświetlone okno z 
komunikatem. Oczywiście w miejscu Atmega128 będzie inna nazwa adekwatna do 
odczytanego id.

Wówczas należy zweryfikować poprawność połączeń między programatorem a 
mikrokontrolerem. Należy również zwrócić uwagę na właściwe zasilanie układu 
oraz upewnić się czy w polu Device prawidłowo został wybrany typ mikrokontrolera.
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6.3 BASCOM-AVR

Programator powinien być przestawiony w tryb AVRDUDE. Tryb AVRDUDE 
sygnalizowany jest czterokrotnym, jednoczesnym mignięciem diody zielonej i żółtej 
chwilę po podłączeniu programatora do komputera. Jeśli po podłączeniu 
programatora diody migną dwa razy, to należy zmienić tryb. Przełączanie trybów 
odbywa się przez krótkotrwałe zwarcie pinów MODE. Na komputerze powinny być 
zainstalowane sterowniki przeznaczone do pracy w tym trybie (rozdział 4.Instalacja 
sterowników do współpracy z BASCOM, AVRDUDE, ECLIPSE, ARDUINO).

Konfigurację programatora w BASCOM-AVR prześledzimy na podstawie wersji 
2.0.7.5 środowiska.

Copyright © 2013 SIBIT www.sibit.pl AVR PROG MKII    30

http://www.sibit.pl/


Uruchamiamy program BASCOM-AVR i przechodzimy do konfiguracji: 
BASCOM->Options->Programmer.

W polu Programmer z rozwijanej listy wybieramy USBprog Programmer / AVR ISP 
mkII, zaznaczamy haczyk przy USB, warto również trochę zwiększyć wartość w 
polu  Timeout USB do np. 200. Wciskamy OK i gotowe.
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6.4 AVRDUDE

Programator powinien być przestawiony w tryb AVRDUDE. Tryb AVRDUDE 
sygnalizowany jest czterokrotnym, jednoczesnym mignięciem diody zielonej i żółtej 
chwilę po podłączeniu programatora do komputera. Jeśli po podłączeniu 
programatora diody migną dwa razy, to należy zmienić tryb. Przełączanie trybów 
odbywa się przez krótkotrwałe zwarcie pinów MODE. Na komputerze powinny być 
zainstalowane sterowniki przeznaczone do pracy w tym trybie (rozdział 4.Instalacja 
sterowników do współpracy z BASCOM, AVRDUDE, ECLIPSE, ARDUINO).

Katalog 'avrdude' ' zamieszczony na dołączonej do zestawu płycie [CD-
>SOFTWARE->AVRDUDE] należy przegrać na dysk twardy. Następnie należy 
zainstalować graficzną nakładkę AVR8-Burn-O Mat znajdującą się w tym katalogu.
Po uruchomieniu nakładki należy ją skonfigurować [Settings->AVRDUDE]. 
W polu 'AVRDUDE location' należy wskazać lokalizację pliku avrdude.exe, w polu 
'alternative AVRDUDE configuration file' należy wskazać plik konfiguracyjny 
'avrdude.conf'. Następnie należy wcisnąć Apply, zrestartować aplikację i dokończyć 
konfigurację wybierając w polu 'Programmer' urządzenie 'avrispmkII(Atmel AVR ISP
mkII)' oraz w polu 'Port' – 'usb'.
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7. Zmiana firmware programatora

7.1 Instalacja programatora w trybie DFU
Do zmiany firmware w programatorze niezbędna jest uprzednia instalacja programu
FLIP dostępnego na stronie Atmela.
Aby programator wprowadzić w tryb DFU (Device Firmware Update) w urządzeniu 
należy założyć zworkę BOOT  i podłączyć do komputera. 
Po podłączeniu, diody STATUS oraz DATA powinny być wygaszone. Przy pierwszej
aktualizacji komputer wykryje nowe urządzenie i uruchomi kreator instalacji.

W kreatorze należy wybrać opcję 'Nie, nie tym razem' i nacisnąć 'Dalej'.
W następnym oknie instalatora należy wybrać opcję 'Zainstaluj z listy lub określonej
lokalizacji (zaawansowane)' i nacisnąć 'Dalej'.
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W następnym kroku należy wskazać lokalizację sterowników. W tym celu 
wybieramy opcję 'Wyszukaj najlepszy sterownik w tych lokalizacjach' oraz 
zaznaczamy 'Uwzględnij tę lokalizację w wyszukiwaniu '. Wciskamy 'Przeglądaj ' i 
wskazujemy lokalizację instalacji programu FLIP  - '...\Atmel\Flip 3.x.x\usb'.
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System powinien znaleźć i zainstalować sterowniki z podanej lokalizacji.

Jeśli proces instalacji przebiegł prawidłowo, Kreator poinformuje o prawidłowym 
zakończeniu instalacji sterowników.

Po wyświetleniu okna końca pracy kreatora należy wcisnąć przycisk 'Zakończ'.
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Po poprawnej instalacji programatora w trybie DFU, w oknie Menadżer urządzeń 
powinna pojawić się gałąź Atmel USB Devices z gałęzią AT90USB162. 
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7.2 Obsługa programu Atmel FLIP

Na potrzeby sporządzenia tej części instrukcji zainstalowany został program 
Atmel Flip w wersji 3.4.7

Po uprzednim wprowadzeniu programatora w tryb DFU (programator podłączony 
do komputera z założoną  zworką BOOT) należy uruchomić program FLIP 
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W programie należy wybrać urządzenie do zaprogramowania -  'Atmel Flip → 
Device -> Select' (można nacisnąć ikonę symbolizującą układ scalony) a następnie 
należy zaznaczyć AT90USB162 i kliknąć 'OK'
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Następnie nacisnąć na ikonkę symbolizującą wtyk USB, wybrać USB i w okienku 
USB Port Connection które się pojawi wcisnąć OPEN:
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Po pomyślnym otwarciu komunikacji z bootloaderem powinny uaktywnić się 
wcześniej niedostępne opcje.

Następnie należy wskazać docelowy plik *.hex z firmware – ikona z książką 
zaznaczona poniżej lub 'File->Load HEX File...' i nacisnąć przycisk Run (lewy dolny
róg). 

Po skończonej aktualizacji należy zamknąć program (File ->Exit), odłączyć 
programator i zdjąć zworkę BOOT.
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8. Lista obsługiwanych układów.

Aktualna lista obsługiwanych mikrokontrolerów dostępna jest pod 
adresem: http://www.atmel.com/tools/avrispmkii.aspx?tab=devices
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9. Nota prawna

Firmware programatora bazuje na projekcie LUFA którego autorem jest Dean 
Camera.  Projekt LUFA (Lightweight USB Framework for AVRs) w chwili obecnej 
jest rozpowszechniany na warunkach zmodyfikowanej licencji MIT. 
Zgodnie z warunkami tej licencji i życzeniem twórcy oprogramowania 
zamieszczamy poniższe informacje odnośnie wsadu programatora:

  Copyright 2010  Dean Camera (dean [at] fourwalledcubicle [dot] com)

  Permission to use, copy, modify, distribute, and sell this 
  software and its documentation for any purpose is hereby granted

  without fee, provided that the above copyright notice appear in 
  all copies and that both that the copyright notice and this

  permission notice and warranty disclaimer appear in supporting 
  documentation, and that the name of the author not be used in 

  advertising or publicity pertaining to distribution of the 
  software without specific, written prior permission.

  The author disclaim all warranties with regard to this
  software, including all implied warranties of merchantability
  and fitness.  In no event shall the author be liable for any

  special, indirect or consequential damages or any damages
  whatsoever resulting from loss of use, data or profits, whether

  in an action of contract, negligence or other tortious action,
  arising out of or in connection with the use or performance of

  this software.
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10. Kontakt - wsparcie techniczne

W celu uzyskania dodatkowej pomocy technicznej skontaktuj się z nami
serwis@sibit.pl

Windows is a registered trademark of Microsoft Corporation.
ATMEL, AVR, XMEGA, FLIP and AVR Studio are the registered trademarks of Atmel.

CodeVisionAVR is trademark of HP InfoTech.
All other brand names or product names are the property of their respective holders.
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